
 With 
 

 Rick Walter 
 

Phone: 717-285-2375  Web Page: www.wb3csy.com 

 E-Mail: wb3csy@embarqmail.com 

 Retired from Manheim Central H.S. (36 yrs -  Earth Science and Astronomy) 

 Taught Computer Classes at Millersville (15 yrs) and Penn State (3 yrs) Universities 

 Teaches at Lancaster-Lebanon IU 13 (>27 yrs - CPE computer classes) 

 

Quick Access Toolbar Document Title Bar 

Close 
Maximize 

Minimize 
Tab 

Ribbon – Changes Based on Tab Chosen 

Groups 

Cell A1 

Status Bar 
Viewing Buttons 

Horizontal Scroll Bar 

Vertical Scroll Bar 

Zoom control 

Column Letters 

Row Numbers 

Worksheet 
Area 

http://www.wb3csy.com/
mailto:wb3csy@embarqmail.com


 

Table of Contents 
 

What is a Spreadsheet? ......................................................................................................................................... 3 
What Do I See When I Begin an Excel Workbook? ............................................................................................ 3 
Ribbon Items ......................................................................................................................................................... 4 
File Tab ................................................................................................................................................................. 5 
The Backstage view from the File Tab ................................................................................................................. 6 
Quick Access Toolbar ........................................................................................................................................... 6 
Creating a New Document .................................................................................................................................... 6 
Using the Dialog Launcher with each group on the Ribbon ............................................................................... 7 
Dialog launcher on the Home Tab ....................................................................................................................... 7 
Dialog launcher on the Insert Tab Dialog launcher on the Page Layout Tab/Scale To Fit/Options ............. 8 
Dialog launcher on the Page Layout Tab/Scale To Fit/Options ......................................................................... 9 
Creating a Spreadsheet ......................................................................................................................................... 9 
Understanding Spreadsheet Basics ...................................................................................................................... 9 
Excel 2010 Keyboard Shortcuts - Ctrl Combination Shortcut Keys .................................................................. 10 
Entering Text and Numbers ............................................................................................................................... 12 
Entering Formulas (Functions) ......................................................................................................................... 12 
Editing Entries .................................................................................................................................................... 12 
Selecting cells ...................................................................................................................................................... 12 
Saving a Worksheet............................................................................................................................................. 13 
Opening an Existing Worksheet ......................................................................................................................... 13 
Using Windows to Split A Screen ....................................................................................................................... 13 
Fill Right and Fill Down Commands ................................................................................................................. 13 
Absolute vs Relative Formulas ........................................................................................................................... 14 
Functions ............................................................................................................................................................ 14 
Excel 2010 Functions Listed By Category ......................................................................................................... 14 
Excel 2010 Functions Listed Alphabetically ...................................................................................................... 23 
Placing a Function in Your Spreadsheet ........................................................................................................... 35 
Editing a Worksheet ............................................................................................................................................ 36 
Formatting a Worksheet or Cells ....................................................................................................................... 37 
Printing a Worksheet .......................................................................................................................................... 37 
Modifying the Quick Access Toolbar ................................................................................................................. 37 
Graphing (Charting) a Worksheet ..................................................................................................................... 38 
Charting Terminology ........................................................................................................................................ 38 
Working with Charts ........................................................................................................................................... 39 
Chart Tools - Design ........................................................................................................................................... 39 
Chart Tools – Layout .......................................................................................................................................... 41 
Customizing Your Chart From the Layout Tab ................................................................................................. 41 
Chart Tools - Format .......................................................................................................................................... 43 
Customizing Your Chart from the Format Tab ................................................................................................. 43 
Sort and Filter Group in the Data Tab ............................................................................................................... 44 
Add-Ins that come with Excel ............................................................................................................................. 45 
Adding the Add-Ins ............................................................................................................................................. 45 
Microsoft Excel Assignments ............................................................................................................................. 46 
Using Microsoft Excel Class Outline ................................................................................................................. 47 

 



Using Microsoft Excel 2010   

Rick Walter Page 3 of 47 Lancaster – Lebanon IU 13 

Row 

Headings 

Active Cell Cell Address 

Column 

Headings 

Insert a Function 

Edit Line 

What is a Spreadsheet? 
A spreadsheet program is like an electronic version of a bookkeeper’s ledger page.  A spreadsheet 

document (or worksheet) is a grid composed of numbered rows and lettered columns.  You enter data into 

worksheet cells which are the intersection of rows and columns.  The size of an Excel can be changed to 

anything you would like as long as it will fit into the RAM of your computer. When you open an Excel 

Workbook, it contains by default, three worksheets or spreadsheets. 

 

The power of the spreadsheet lies in its calculation capabilities.  You can mathematically combine the 

contents of cells by creating formulas, called functions, that add, subtract, divide, or multiply cells by 

each other or constants.  The Excel environment also offers a large number of mathematical, statistical, 

time, text, financial, and logical functions that enable the user to perform very complex calculations. 

 

The spreadsheet is the ideal environment for data that requires calculations.  It is frequently used for 

accounting, bookkeeping, and record keeping.  You can use the charting, graphing,  capabilities to 

summarize any portion of your data pictorially.  You can also place spreadsheet frames into your word 

processing documents to have tables of data. Spreadsheets make booking for teachers a breeze. 

 

The intersection of a row and column is called a cell.  Cells are given an address or reference from the 

column and row that make them.  Three basic things can be entered into a cell: text (labels), numbers 

(values), and formulas (functions) that refer to cells.   

 

 

 

 

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 

What Do I See When I Begin an Excel Workbook?  
The items you see on the Excel window are labeled on the title page of this handout. More specifics are 

listed below:  

 

Title Bar – Located at the top of every Excel window, it shows the name of the current file as well as 

the standard buttons Windows provides on every window such as minimize, restore, and close.  
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Ribbon – Located below the title bar, this item was added starting with Excel 2007. The ribbon 

contains all the items you will use with Excel 2010. Think of it as a new way to display the old menu 

items. The exact appearance of the ribbon will vary depending on what task you are currently doing. 

It changes when you click on different tabs on top of the ribbon. Each ribbon has groups of related 

tasks separated by a vertical line. Some groups have a very small box with an arrow pointing down 

and to the right located at the right bottom. When you click this box, you launch a dialog box related 

to the group. Not all groups have this dialog box launcher.  

 

File Tab- The file tab replaces the office button used in version 2007. You launch “Backstage View” 

when you click on the file tab. This feature is described later in this handout.  

 

Quick Access Toolbar – Customized by the user, this toolbar can hold commands you most often 

use.  

 

Ruler – A vertical and horizontal ruler allow you to view the location of objects on the page. For 

draw objects, you may see their relative size. The ruler is necessary to place tabs in your document.  

 

Task Pane – Some commands you choose to use in Excel open a “task pane.” An example is the 

clipboard. Since you may have multiple items on the clipboard, the task pain allows you to choose 

what you would like to paste among those listed.  

 

Status Bar – This item allows you to see what spreadsheet you selected in the current workbook.  

 

View Buttons –The five buttons located at the right bottom of the text window allows you to view 

the spreadsheet in various formats.  

 

Zoom Control – The + and – buttons allow you to zoom in or out while viewing your document. 

Zooming in makes it easy to view details while using the draw tools in the illustrations group.  

Ribbon Items 
Home Ribbon – The home ribbon is used to create, format, and edit a spreadsheet. It contains the 

Clipboard, Font, alignment, Number, Styles, Cells, and the Editing groups. 

Insert Ribbon – This ribbon is used when adding items to your spreadsheet. Examples include graphics, 

charts, PivotTables, headers and footers, charts, and hyperlinks. It contains the Tables, Illustrations, 

Sparklines, Filter, Charts, Text, and Links groups.  

Page Layout Ribbon – This ribbon is used to set up your spreadsheet for printing. The groups in this 
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ribbon include Page Setup, Themes, Scale to fit, spreadsheet options, and Arrange. 

Formula Ribbon – This ribbon allows you to choose and check for function errors. The groups in this 

ribbon include Function Library, Defined names, Formula Auditing, and Calculation. 

Data Ribbon – This ribbon allows you to import, query, and subtotal data. The group includes Get 

External Data, Connections, Sort & Filter, Data Tools, and Outline. If add-ins is activated, the Analysis 

Toolpak and Solver are included. 

Review Ribbon – This ribbon allows you to proof, protect, and mark up a spreadsheet. The groups in this 

ribbon include Proofing, Language, Comment, and Changes. 

View Ribbon – This ribbon allows you to change the display of the worksheet area and the data in it. The 

groups in this ribbon include Workbook views, Show, Zoom, Window, and Macro Groups. 

 
Unlike Excel 2007, version 2010 allows you to create your own groups and tabs on the ribbon. 

 

When the user selects specific items on some ribbons, new groups will appear. These items are only used 

with the current task. 

File Tab 
The File tab allows the user to review specific information about the document you 

are currently viewing. The following sections are in the File tab: 

 

Save – allows the user to save the current file in the same place used last 

Save As - allows the user to save the current file in a specific place 

Open – allows you to open a file which was saved on your computer’s hard drive 

Close – allows you to close a currently open file 

Info – Provides information about the file you are currently viewing 

Recent – shows the files you rcently modified, and provide their location 

New – allows you to create a new blank document, or use a template 

Print – provides various methods to print your document (including a PDF) 
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Save & Send – Allows you to send your document as an attachement to an e-mail, a link to your 

document, attach a PDF file of your document, create an XPS form of your document, or send a fax of 

your document 

Help – All the help you will ever need 

Options – Allows you to modify Excel to your preferences 

The Backstage view from the File Tab 
 

What you see in the backstage view from the file tab depends on  if you have a file open in Excel. A great 

deal of information is displayed in this mode. Some items displayed using info while in the backstage 

view follows: 

 

 Compatibility Mode – If you have a file created with an earlier version of Excel, a convert 

button allows you to convert the older versions of Excel to the current version. This makes 

updating easy.  When updating you may lose some formatting in the original document. 

 Permission – Indicates if the current document is locked or unlocked. You have the ability to set 

a password for controlling who may view your documents. 

 Prepare for Sharing – Allows you to check your document for revisions. You may search for 

specific issues before sharing your document with others. 

 Versions – If you saved your document multiple times during revisions, you may be able to 

retrieve older versions. 

Quick Access Toolbar 
 

The Quick Access Toolbar provides a place to access the most common commands you will use with 

Excel 2010. You may customize this toolbar to provide quick access to what items you commonly use. 

 

Creating a New Document 
A new document may be created by simply launching Microsoft Excel, pressing Control + N while 

viewing a spreadsheet, clicking new on the Quick Access Toolbar, or choosing file, New, then clicking 

the blank Document icon. The backstage view includes a command for a new document. Normally, when 

you create a new spreadsheet, it looks for a template labeled Normal.dotm. 
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If you choose to create a new spreadsheet from the new page option from the Quick Access Toolbar, you 

will see several alternatives to creating a simple blank spreadsheet. The choices are: 
 

 

 Blank Workbook  – This will create a new spreadsheet just as if you clicked the new button on 

the quick access toolbar. 

 Recent Templates – Click this icon to see the recently used templates for your documents. 

 Sample Templates – Click this icon to view the multitude of templates provided by Microsoft. 

 My Templates – Click this icon to choose from templates you created. 

 New from Exisiting - Click this icon to choose from  

 

Using the Dialog Launcher with each group on the Ribbon 
When you wish to bring up a menu that allows you to make many changes to a particular group on the 

ribbon, you use the Dialog Launcher. If you look carefully at most groups on the ribbon, you will see a 

small box in the right bottom corner with a small arrow pointing to the right bottom.  These boxes allow 

you to launch a large menu with several tabs. Examples follow: 

 

 

 

 

Dialog launcher on the Home Tab 
 

Font      Alignment 
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Number 

 

 

 

 

 

 

 

 

 

 

 

 

 

Dialog launcher on the Insert Tab Dialog launcher on the Page 
Layout Tab/Scale To Fit/Options 

Charts       Page 
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Dialog launcher on the Page Layout Tab/Scale To Fit/Options 
Margins     Header/Footer 

 
 
 
 

 

 

 

 
 
 

 

Sheet 

 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Creating a Spreadsheet 
You can open a workbook that contains three blank spreadsheets by launching the Excel program. 

Understanding Spreadsheet Basics 
Spreadsheets locations are identified by a letter and number coordinate.  The location is called a “cell”. 

The cell in the upper left hand corner of the spreadsheet has the coordinate of “A1”.  The current cell has 

a double border called the “active” cell.  To make a different cell active, you can click another with the 

mouse or move to a new cell with the cursor keys or combinations of keys listed in this handout.  

 

The letter and number combination for a cell is called the cell address.  A cell address identifies every cell 

on the total spreadsheet.  You can use the cell address when writing a formula.  To add cells A1 and B1 

together and place the answer in C1, you would make C1 active, and type =A1+B1. When you begin 

typing something with a “=” sign, Excel knows you are entering a formula.  Sometimes you will wish to 
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use the value “=” as a label. To do so, you would type =”=” in the edit line.  The first = tells the 

spreadsheet a formula follows, then the “=” tells the program to treat the item(s) in parenthesis as text. 

 

It is possible to combine several cell addresses in a formula such as: =B6*15/S23+f43+2.88. You can also 

work with a range of cells such as (a4:a20).  These ranges may be used in formulas with  built in 

functions such as:  SUM(A2:A10).  This command would add all the values in the cell addresses from A2 

to A10 inclusive.  You may use upper or lower case when typing cell addresses.  Do not use spaces in a 

formula. 

Excel 2010 Keyboard Shortcuts - Ctrl Combination Shortcut Keys 

 
Key  Description  Key  Description  
CTRL+PgUp  Switches between worksheet tabs, from 

left-to-right.  
CTRL+SHIFT+Plus 
(+)  

Displays Insert dialog box 
to insert blank cells.  

CTRL+PgDn  Switches between worksheet tabs, from 
right-to-left.  

CTRL+Minus (-)  Displays Delete dialog box 
to delete selected cells.  

CTRL+SHIFT+(  Unhide hidden rows within the selection.  CTRL+;  Enters current date.  

CTRL+SHIFT+&  Applies outline border to selected cells.  CTRL+'  Copies a formula from the 
cell above the active cell 
into the cell or the 
Formula Bar.  

CTRL+SHIFT_  Removes outline border from selected 
cells.  

CTRL+1  Displays Format Cells 
dialog box.  

CTRL+SHIFT+~  Applies General number format.  CTRL+2  Applies or removes bold 
formatting.  

CTRL+SHIFT+$  Applies Currency format with two 
decimal places (negative numbers in 
parentheses).  

CTRL+3  Applies or removes italic 
formatting.  

CTRL+SHIFT+%  Applies Percentage format with no 
decimal places.  

CTRL+4  Applies or removes 
underlining.  

CTRL+SHIFT+^  Applies Scientific number format with 
two decimal places.  

CTRL+5  Applies or removes 
strikethrough.  

CTRL+SHIFT+#  Applies Date format with day, month, 
and year.  

CTRL+6  Alternates between 
hiding and displaying 
objects.  

CTRL+SHIFT+@  Applies Time format with the hour and 
minute, and AM or PM.  

CTRL+8  Displays or hides the 
outline symbols.  

CTRL+SHIFT+!  Applies Number format with two decimal 
places, thousands separator, and minus 
sign (-) for negative values.  

CTRL+9  Hides selected rows.  

CTRL+SHIFT+*  Selects current region around active cells. 
In PivotTables, it selects entire PivotTable 
reports.  

CTRL+0  Hides the selected 
columns.  

CTRL+SHIFT+:  Enters the current time.  CTRL+A  Selects entire worksheet.  
CTRL+`  Alternates between displaying cell values 

and displaying formulas.  
CTRL+SHIFT+A  Inserts argument names 

and parentheses when 
insertion point is to the 
right of function names in 
formulas.  
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CTRL+SHIFT+"  

Copies value from cell above an active 
cell into the cell or the Formula Bar.  

CTRL+B  Applies or removes bold 
formatting.  

 
CTRL+C  Copies selected cells.  CTRL+P  Displays Print tab in 

Microsoft Office Backstage 
view.  

CTRL+D  Uses Fill Down command 
to copy the contents and 
format of the topmost cell 
of a selected range into 
the cells below.  

CTRL+SHIFT+P  Opens Format Cells dialog 
box with the Font tab 
selected.  

CTRL+F  Displays Find and Replace 
dialog box, with the Find 
tab selected.  

CTRL+R  Uses Fill Right command 
to copy the contents and 
format of the leftmost cell 
of a selected range into 
the cells to the right.  

CTRL+SHIFT+F  Opens Format Cells dialog 
box with the Font tab 
selected.  

CTRL+S  Saves the active file with 
its current file name, 
location, and file format.  

CTRL+G  Displays Go To dialog box.  CTRL+T  Displays Create Table 
dialog box.  

CTRL+H  Displays Find and Replace 
dialog box, with Replace 
tab selected.  

CTRL+U  Applies or removes 
underlining.  

CTRL+I  Applies or removes italic 
formatting.  

CTRL+SHIFT+U  Switches between 
expanding and collapsing 
of the formula bar.  

CTRL+K  Displays Insert Hyperlink 
dialog box for new 
hyperlinks or Edit 
Hyperlink dialog box for 
selected existing 
hyperlinks.  

CTRL+V  Inserts contents of the 
Clipboard at the insertion 
point and replaces any 
selection. Available only 
after cutting or copying an 
object, text, or cell 
contents.  

CTRL+L  Displays Create Table 
dialog box.  

CTRL+ALT+V  Displays Paste Special 
dialog box. Available only 
after cutting or copying an 
object, text, or cell 
contents on a worksheet 
or in another program.  

CTRL+N  Creates a new, blank 
workbook.  

CTRL+W  Closes selected workbook 
window.  

CTRL+O  Displays Open dialog box 
to open or find a file.  

CTRL+X  Cuts selected cells.  

CTRL+SHIFT+O  Selects all cells that 
contain comments.  

CTRL+Y  Repeats last command or 
action, if possible.  

CTRL+Z  Uses Undo command to reverse the last command or to 
delete the last entry that you typed.  
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Entering Text and Numbers 
To enter either text (labels) or numbers (values), move to desired cell and type the text or number and use 

a movement method listed above or the enter key to complete entry.  Text (labels) will automatically left 

align and numbers (values) will right align.  When entering numbers, it is best to not type formatting 

symbols such as dollar signs, commas, percent signs, etc.  The formatting options in the program will take 

care of that task for you. The information in a cell can only display the amount of space assigned to that 

cell. The total value or label is contained in each cell. In the case of a label, it may be truncated unil you 

provide more space in the cell. In the case of a value, you may see ####### symbols indicating the value 

cannot fit in the space provided. 

Entering Formulas (Functions) 
To enter a formula on the edit bar, type "=", then the formula you desire.  Whenever possible refer to 

cells, not the actual numbers.  By using cell addresses as a reference, you can change the spreadsheet data 

at anytime and not have to re-write any part of the spreadsheet. 

Editing Entries 
Entries are usually short, therefore, the easiest way to correct an entry is to move to the cell and re-type it.  

However, the mouse can be moved into the edit bar and clicked to insert the cursor wherever necessary. 

The edit features are exactly like those used in the word processor. 

Selecting cells 

 A range of cells can be selected by dragging through the desired cells or making the active cell be one 

of the corner cells and holding down the shift key while clicking the mouse on the opposite corner. 

This is known as the shift-click technique. 

 An entire row can be selected by clicking on the row number desired.  An entire column can be 

selected by clicking on the column letter desired.  You can also drag through the column letters or 

row numbers to select several columns or rows.   

 You can select several rows or columns that are not adjacent by using the control key as you click the 

mouse. 
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Saving a Worksheet 

To save a worksheet, choose Save or Save As in the 

File Tab.  Save will update the worksheet, destroying 

the old version.  Save As will take you to a dialog 

box, which allows you to change the name or 

location you wish to save to, before saving.  If the 

name is changed, both the old and new version of 
the worksheet will be saved. It is always wise to use 

the “Save as” command so you may decide where the 

file will actually be saved.  

Opening an Existing Worksheet 
To open an existing worksheet, choose Open in the 

File Menu.  Use the resulting dialog box to locate and 

highlight the desired folder location and file name.  

Click on Open or double click the file name. 

Using Windows to Split A Screen 
In a larger worksheet it is often necessary to split the 

screen in order to see two different parts of the 

worksheet at the same time.  The black rectangle at 

the top of the right scroll bar and at the far left of the 

bottom scroll bar can be used to do this. Simply place the cursor over the bar and drag it to the place on 

the spreadsheet you wish to break into two parts.  The bars may be used to break the spreadsheet in both 

horizontal and vertical portions.  

 

 

 

 

 

 

Fill Right and Fill Down Commands 
Most spreadsheets will have similar formulas moving to the bottom of a columns and some will repeat 

formulas moving to the right across a row. The Fill Right and Fill Down commands (Editing Group on 

the home Tab) automate entering these redundant formulas.  The formula can be entered once and filled 

into the similar cells. 

 

 

Splt Window 
Vertically 

Splt Window 
Horizontally 
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To use these commands, highlight the range of cells where the similar formulas are needed (making sure 

the top cell highlighted or left most cell highlighted has the formula), and choose either Fill Down or Fill 

Right in the Edit group on the Home tab. Control D or Control R quick keys help speed up this action. 

Absolute vs Relative Formulas 
Formulas in Excel are relative by default. When a formula is entered in a spreadsheet and copied down or 

across a page, the program assumes you wish that formula to apply to other cells on the page. The 

formula is actually re-written so reference cells apply to the current calculation and give the correct 

answer.  However, there are occasions when the relative nature of formulas will cause formulas that are 

filled or copied not to work.  Formulas can be made absolute.  An absolute formula refers to a specific 

cell and only to a specific cell.   

 
To make a formula or part of a formula be absolute, type the "$" sign before the column letter and/or row 

number, such as F$3. To see an example of an absolute reference in a formula, look at the mulch guide 

spreadsheet example. 

Functions 
Functions are special mathematical formulas built into Excel.  Functions can greatly simplify and shorten 

formulas you would otherwise have to create.  Functions often carry out very sophisticated and complex 

calculations.  All the user needs to know is the function's name and the parts it requires.  Examples of 

common functions are: 

 

 Sum - totals a set of numbers 

 Average -  averages a set of numbers 

 Minimum -  gives the lowest number in a set of numbers 

 Maximum -  gives the highest number in a set of numbers 

 Yearly Payment -  gives the yearly payment for a loan 

 

Excel 2010 Functions Listed By Category 

 

Database functions 

 
Function Description 

DAVERAGE Returns the average of selected database entries 

DCOUNT Counts the cells that contain numbers in a database 

DCOUNTA Counts nonblank cells in a database 

DGET Extracts from a database a single record that matches the specified criteria 

DMAX Returns the maximum value from selected database entries 

DMIN Returns the minimum value from selected database entries 

DPRODUCT Multiplies the values in a particular field of records that match the criteria in a 

database 

DSTDEV Estimates the standard deviation based on a sample of selected database entries 

DSTDEVP Calculates the standard deviation based on the entire population of selected database 

entries 

DSUM Adds the numbers in the field column of records in the database that match the 

criteria 

DVAR Estimates variance based on a sample from selected database entries 
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DVARP Calculates variance based on the entire population of selected database entries 

 

Date and Time functions 
  

Function Description 

DATE Returns the serial number of a particular date 

DATEVALUE Converts a date in the form of text to a serial number 

DAY Converts a serial number to a day of the month 

DAYS360 Calculates the number of days between two dates based on a 360-day year 

EDATE Returns the serial number of the date that is the indicated number of months before or 

after the start date 

EOMONTH Returns the serial number of the last day of the month before or after a specified 

number of months 

HOUR Converts a serial number to an hour 

MINUTE Converts a serial number to a minute 

MONTH Converts a serial number to a month 

NETWORKDAYS Returns the number of whole workdays between two dates 

NOW Returns the serial number of the current date and time 

SECOND Converts a serial number to a second 

TIME Returns the serial number of a particular time 

TIMEVALUE Converts a time in the form of text to a serial number 

TODAY Returns the serial number of today's date 

WEEKDAY Converts a serial number to a day of the week 

WEEKNUM Converts a serial number to a number representing where the week falls numerically 

with a year 

WORKDAY Returns the serial number of the date before or after a specified number of workdays 

YEAR Converts a serial number to a year 

YEARFRAC Returns the year fraction representing the number of whole days between start date 

and end date 

 

Engineering functions 
  

Function Description 

BESSELI Returns the modified Bessel function In(x) 

BESSELJ Returns the Bessel function Jn(x) 

BESSELK Returns the modified Bessel function Kn(x) 

BESSELY Returns the Bessel function Yn(x) 

BIN2DEC Converts a binary number to decimal 

BIN2HEX Converts a binary number to hexadecimal 

BIN2OCT Converts a binary number to octal 

COMPLEX Converts real and imaginary coefficients into a complex number 

CONVERT Converts a number from one measurement system to another 

DEC2BIN Converts a decimal number to binary 

DEC2HEX Converts a decimal number to hexadecimal 

DEC2OCT Converts a decimal number to octal 

DELTA Tests whether two values are equal 

ERF Returns the error function 

ERFC Returns the complementary error function 

GESTEP Tests whether a number is greater than a threshold value 

HEX2BIN Converts a hexadecimal number to binary 
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HEX2DEC Converts a hexadecimal number to decimal 

HEX2OCT Converts a hexadecimal number to octal 

IMABS Returns the absolute value (modulus) of a complex number 

IMAGINARY Returns the imaginary coefficient of a complex number 

IMARGUMENT Returns the argument theta, an angle expressed in radians 

IMCONJUGATE Returns the complex conjugate of a complex number 

IMCOS Returns the cosine of a complex number 

IMDIV Returns the quotient of two complex numbers 

IMEXP Returns the exponential of a complex number 

IMLN Returns the natural logarithm of a complex number 

IMLOG10 Returns the base-10 logarithm of a complex number 

IMLOG2 Returns the base-2 logarithm of a complex number 

IMPOWER Returns a complex number raised to an integer power 

IMPRODUCT Returns the product of from 2 to 29 complex numbers 

IMREAL Returns the real coefficient of a complex number 

IMSIN Returns the sine of a complex number 

IMSQRT Returns the square root of a complex number 

IMSUB Returns the difference between two complex numbers 

IMSUM Returns the sum of complex numbers 

OCT2BIN Converts an octal number to binary 

OCT2DEC Converts an octal number to decimal 

OCT2HEX Converts an octal number to hexadecimal 

 

Financial functions 
  

Function Description 

ACCRINT Returns the accrued interest for a security that pays periodic interest 

ACCRINTM Returns the accrued interest for a security that pays interest at maturity 

AMORDEGRC Returns the depreciation for each accounting period by using a depreciation 

coefficient 

Function Description 

AMORLINC Returns the depreciation for each accounting period 

COUPDAYBS Returns the number of days from the beginning of the coupon period to the 

settlement date 

COUPDAYS Returns the number of days in the coupon period that contains the settlement date 

COUPDAYSNC Returns the number of days from the settlement date to the next coupon date 

COUPNCD Returns the next coupon date after the settlement date 

COUPNUM Returns the number of coupons payable between the settlement date and maturity 

date 

COUPPCD Returns the previous coupon date before the settlement date 

CUMIPMT Returns the cumulative interest paid between two periods 

CUMPRINC Returns the cumulative principal paid on a loan between two periods 

DB Returns the depreciation of an asset for a specified period by using the fixed-

declining balance method 

DDB Returns the depreciation of an asset for a specified period by using the double-

declining balance method or some other method that you specify 

DISC Returns the discount rate for a security 

DOLLARDE Converts a dollar price, expressed as a fraction, into a dollar price, expressed as a 

decimal number 
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DOLLARFR Converts a dollar price, expressed as a decimal number, into a dollar price, expressed 

as a fraction 

DURATION Returns the annual duration of a security with periodic interest payments 

EFFECT Returns the effective annual interest rate 

FV Returns the future value of an investment 

FVSCHEDULE Returns the future value of an initial principal after applying a series of compound 

interest rates 

INTRATE Returns the interest rate for a fully invested security 

IPMT Returns the interest payment for an investment for a given period 

IRR Returns the internal rate of return for a series of cash flows 

ISPMT Calculates the interest paid during a specific period of an investment 

MDURATION Returns the Macauley modified duration for a security with an assumed par value of 

$100 

MIRR Returns the internal rate of return where positive and negative cash flows are 

financed at different rates 

NOMINAL Returns the annual nominal interest rate 

NPER Returns the number of periods for an investment 

NPV Returns the net present value of an investment based on a series of periodic cash 

flows and a discount rate 

ODDFPRICE Returns the price per $100 face value of a security with an odd first period 

ODDFYIELD Returns the yield of a security with an odd first period 

ODDLPRICE Returns the price per $100 face value of a security with an odd last period 

ODDLYIELD Returns the yield of a security with an odd last period 

PMT Returns the periodic payment for an annuity 

PPMT Returns the payment on the principal for an investment for a given period 

PRICE Returns the price per $100 face value of a security that pays periodic interest 

PRICEDISC Returns the price per $100 face value of a discounted security 

PRICEMAT Returns the price per $100 face value of a security that pays interest at maturity 

PV Returns the present value of an investment 

RATE Returns the interest rate per period of an annuity 

RECEIVED Returns the amount received at maturity for a fully invested security 

SLN Returns the straight-line depreciation of an asset for one period 

SYD Returns the sum-of-years' digits depreciation of an asset for a specified period 

TBILLEQ Returns the bond-equivalent yield for a Treasury bill 

TBILLPRICE Returns the price per $100 face value for a Treasury bill 

TBILLYIELD Returns the yield for a Treasury bill 

VDB Returns the depreciation of an asset for a specified or partial period by using a 

declining balance method 

XIRR Returns the internal rate of return for a schedule of cash flows that is not necessarily 

periodic 

XNPV Returns the net present value for a schedule of cash flows that is not necessarily 

periodic 

YIELD Returns the yield on a security that pays periodic interest 

YIELDDISC Returns the annual yield for a discounted security; for example, a Treasury bill 

YIELDMAT Returns the annual yield of a security that pays interest at maturity 
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Information functions 
  

Function Description 

CELL Returns information about the formatting, location, or contents of a cell 

ERROR.TYPE Returns a number corresponding to an error type 

INFO Returns information about the current operating environment 

ISBLANK Returns TRUE if the value is blank 

ISERR Returns TRUE if the value is any error value except #N/A 

ISERROR Returns TRUE if the value is any error value 

ISEVEN Returns TRUE if the number is even 

ISLOGICAL Returns TRUE if the value is a logical value 

ISNA Returns TRUE if the value is the #N/A error value 

ISNONTEXT Returns TRUE if the value is not text 

ISNUMBER Returns TRUE if the value is a number 

ISODD Returns TRUE if the number is odd 

ISREF Returns TRUE if the value is a reference 

ISTEXT Returns TRUE if the value is text 

N Returns a value converted to a number 

NA Returns the error value #N/A 

TYPE Returns a number indicating the data type of a value 

 

Logical functions 
  

Function Description 

AND Returns TRUE if all of its arguments are TRUE 

FALSE Returns the logical value FALSE 

IF Specifies a logical test to perform 

NOT Reverses the logic of its argument 

OR Returns TRUE if any argument is TRUE 

TRUE Returns the logical value TRUE 

 

  

Lookup and reference functions 
  

Function Description 

ADDRESS Returns a reference as text to a single cell in a worksheet 

AREAS Returns the number of areas in a reference 

CHOOSE Chooses a value from a list of values 

COLUMN Returns the column number of a reference 

COLUMNS Returns the number of columns in a reference 

GETPIVOTDATA Returns data stored in a PivotTable 

HLOOKUP Looks in the top row of an array and returns the value of the indicated cell 

HYPERLINK Creates a shortcut or jump that opens a document stored on a network server, an 

intranet, or the Internet 

INDEX Uses an index to choose a value from a reference or array 

INDIRECT Returns a reference indicated by a text value 

LOOKUP Looks up values in a vector or array 

MATCH Looks up values in a reference or array 

OFFSET Returns a reference offset from a given reference 

ROW Returns the row number of a reference 
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ROWS Returns the number of rows in a reference 

RTD Retrieves real-time data from a program that supports COM automation 

TRANSPOSE Returns the transpose of an array 

VLOOKUP Looks in the first column of an array and moves across the row to return the value of 

a cell 

 

 Math and trigonometry functions 

  

Function Description 

ABS Returns the absolute value of a number 

ACOS Returns the arccosine of a number 

ACOSH Returns the inverse hyperbolic cosine of a number 

ASIN Returns the arcsine of a number 

ASINH Returns the inverse hyperbolic sine of a number 

ATAN Returns the arctangent of a number 

ATAN2 Returns the arctangent from x- and y-coordinates 

ATANH Returns the inverse hyperbolic tangent of a number 

CEILING Rounds a number to the nearest integer or to the nearest multiple of significance 

COMBIN Returns the number of combinations for a given number of objects 

COS Returns the cosine of a number 

COSH Returns the hyperbolic cosine of a number 

DEGREES Converts radians to degrees 

EVEN Rounds a number up to the nearest even integer 

EXP Returns e raised to the power of a given number 

FACT Returns the factorial of a number 

FACTDOUBLE Returns the double factorial of a number 

FLOOR Rounds a number down, toward zero 

GCD Returns the greatest common divisor 

INT Rounds a number down to the nearest integer 

LCM Returns the least common multiple 

LN Returns the natural logarithm of a number 

LOG Returns the logarithm of a number to a specified base 

LOG10 Returns the base-10 logarithm of a number 

MDETERM Returns the matrix determinant of an array 

MINVERSE Returns the matrix inverse of an array 

MMULT Returns the matrix product of two arrays 

MOD Returns the remainder from division 

MROUND Returns a number rounded to the desired multiple 

MULTINOMIAL Returns the multinomial of a set of numbers 

ODD Rounds a number up to the nearest odd integer 

PI Returns the value of pi 

POWER Returns the result of a number raised to a power 

PRODUCT Multiplies its arguments 

QUOTIENT Returns the integer portion of a division 

RADIANS Converts degrees to radians 

RAND Returns a random number between 0 and 1 

RANDBETWEEN Returns a random number between the numbers you specify 

ROMAN Converts an Arabic numeral to roman, as text 

ROUND Rounds a number to a specified number of digits 

ROUNDDOWN Rounds a number down, toward zero 
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ROUNDUP Rounds a number up, away from zero 

SERIESSUM Returns the sum of a power series based on the formula 

SIGN Returns the sign of a number 

SIN Returns the sine of the given angle 

SINH Returns the hyperbolic sine of a number 

SQRT Returns a positive square root 

SQRTPI Returns the square root of (number * pi) 

SUBTOTAL Returns a subtotal in a list or database 

SUM Adds its arguments 

SUMIF Adds the cells specified by a given criteria 

SUMPRODUCT Returns the sum of the products of corresponding array components 

SUMSQ Returns the sum of the squares of the arguments 

SUMX2MY2 Returns the sum of the difference of squares of corresponding values in two arrays 

SUMX2PY2 Returns the sum of the sum of squares of corresponding values in two arrays 

SUMXMY2 Returns the sum of squares of differences of corresponding values in two arrays 

TAN Returns the tangent of a number 

TANH Returns the hyperbolic tangent of a number 

TRUNC Truncates a number to an integer 

 

  

Statistical functions 
  

Function Description 

AVEDEV Returns the average of the absolute deviations of data points from their mean 

AVERAGE Returns the average of its arguments 

AVERAGEA Returns the average of its arguments, including numbers, text, and logical values 

BETADIST Returns the beta cumulative distribution function 

BETAINV Returns the inverse of the cumulative distribution function for a specified beta 

distribution 

BINOMDIST Returns the individual term binomial distribution probability 

CHIDIST Returns the one-tailed probability of the chi-squared distribution 

CHIINV Returns the inverse of the one-tailed probability of the chi-squared distribution 

CHITEST Returns the test for independence 

CONFIDENCE Returns the confidence interval for a population mean 

CORREL Returns the correlation coefficient between two data sets 

COUNT Counts how many numbers are in the list of arguments 

COUNTA Counts how many values are in the list of arguments 

COUNTBLANK Counts the number of blank cells within a range 

COUNTIF Counts the number of nonblank cells within a range that meet the given criteria 

COVAR Returns covariance, the average of the products of paired deviations 

CRITBINOM Returns the smallest value for which the cumulative binomial distribution is less than 

or equal to a criterion value 

DEVSQ Returns the sum of squares of deviations 

EXPONDIST Returns the exponential distribution 

FDIST Returns the F probability distribution 

FINV Returns the inverse of the F probability distribution 

FISHER Returns the Fisher transformation 

FISHERINV Returns the inverse of the Fisher transformation 

FORECAST Returns a value along a linear trend 

FREQUENCY Returns a frequency distribution as a vertical array 
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FTEST Returns the result of an F-test 

GAMMADIST Returns the gamma distribution 

GAMMAINV Returns the inverse of the gamma cumulative distribution 

GAMMALN Returns the natural logarithm of the gamma function, Γ(x) 

GEOMEAN Returns the geometric mean 

GROWTH Returns values along an exponential trend 

HARMEAN Returns the harmonic mean 

HYPGEOMDIST Returns the hypergeometric distribution 

INTERCEPT Returns the intercept of the linear regression line 

KURT Returns the kurtosis of a data set 

LARGE Returns the k-th largest value in a data set 

LINEST Returns the parameters of a linear trend 

LOGEST Returns the parameters of an exponential trend 

LOGINV Returns the inverse of the lognormal distribution 

LOGNORMDIST Returns the cumulative lognormal distribution 

MAX Returns the maximum value in a list of arguments 

MAXA Returns the maximum value in a list of arguments, including numbers, text, and 

logical values 

MEDIAN Returns the median of the given numbers 

MIN Returns the minimum value in a list of arguments 

MINA Returns the smallest value in a list of arguments, including numbers, text, and logical 

values 

MODE Returns the most common value in a data set 

NEGBINOMDIST Returns the negative binomial distribution 

NORMDIST Returns the normal cumulative distribution 

NORMINV Returns the inverse of the normal cumulative distribution 

NORMSDIST Returns the standard normal cumulative distribution 

NORMSINV Returns the inverse of the standard normal cumulative distribution 

PEARSON Returns the Pearson product moment correlation coefficient 

PERCENTILE Returns the k-th percentile of values in a range 

PERCENTRANK Returns the percentage rank of a value in a data set 

PERMUT Returns the number of permutations for a given number of objects 

POISSON Returns the Poisson distribution 

PROB Returns the probability that values in a range are between two limits 

QUARTILE Returns the quartile of a data set 

RANK Returns the rank of a number in a list of numbers 

RSQ Returns the square of the Pearson product moment correlation coefficient 

SKEW Returns the skewness of a distribution 

SLOPE Returns the slope of the linear regression line 

SMALL Returns the k-th smallest value in a data set 

STANDARDIZE Returns a normalized value 

STDEV Estimates standard deviation based on a sample 

STDEVA Estimates standard deviation based on a sample, including numbers, text, and logical 

values 

STDEVP Calculates standard deviation based on the entire population 

STDEVPA Calculates standard deviation based on the entire population, including numbers, text, 

and logical values 

STEYX Returns the standard error of the predicted y-value for each x in the regression 

TDIST Returns the Student's t-distribution 

TINV Returns the inverse of the Student's t-distribution 

TREND Returns values along a linear trend 
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TRIMMEAN Returns the mean of the interior of a data set 

TTEST Returns the probability associated with a Student's t-test 

VAR Estimates variance based on a sample 

VARA Estimates variance based on a sample, including numbers, text, and logical values 

VARP Calculates variance based on the entire population 

VARPA Calculates variance based on the entire population, including numbers, text, and 

logical values 

WEIBULL Returns the Weibull distribution 

ZTEST Returns the one-tailed probability-value of a z-test 

 

 Text functions 

  

Function Description 

ASC Changes full-width (double-byte) English letters or katakana within a character string 

to half-width (single-byte) characters 

BAHTTEXT Converts a number to text, using the ß (baht) currency format 

CHAR Returns the character specified by the code number 

CLEAN Removes all nonprintable characters from text 

CODE Returns a numeric code for the first character in a text string 

CONCATENATE Joins several text items into one text item 

DOLLAR Converts a number to text, using the $ (dollar) currency format 

EXACT Checks to see if two text values are identical 

FIND, FINDB Finds one text value within another (case-sensitive) 

FIXED Formats a number as text with a fixed number of decimals 

JIS Changes half-width (single-byte) English letters or katakana within a 

character string to full-width (double-byte) characters 

LEFT, LEFTB Returns the leftmost characters from a text value 

LEN, LENB Returns the number of characters in a text string 

LOWER Converts text to lowercase 

MID, MIDB Returns a specific number of characters from a text string starting at the 

position you specify 

PHONETIC Extracts the phonetic (furigana) characters from a text string 

PROPER Capitalizes the first letter in each word of a text value 

REPLACE, REPLACEB Replaces characters within text 

REPT Repeats text a given number of times 

RIGHT, RIGHTB Returns the rightmost characters from a text value 

SEARCH, SEARCHB Finds one text value within another (not case-sensitive) 

SUBSTITUTE Substitutes new text for old text in a text string 

T Converts its arguments to text 

TEXT Formats a number and converts it to text 

TRIM Removes spaces from text 

UPPER Converts text to uppercase 

VALUE Converts a text argument to a number 

 

External functions 
  

Function Description 

EUROCONVERT Converts a number to euros, converts a number from euros to a euro 

member currency, or converts a number from one euro member currency to 

another by using the euro as an intermediary (triangulation) 
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SQL.REQUEST Connects with an external data source and runs a query from a worksheet, 

then returns the result as an array without the need for macro programming 

 

Excel 2010 Functions Listed Alphabetically 

 
Function Category Description 

ABS  Math and trigonometry Returns the absolute value of a number 

ACCRINT  Financial Returns the accrued interest for a security that pays 

periodic interest 

ACCRINTM  Financial     Returns the accrued interest for a security that pays 

interest at maturity 

ACOS  Math and trigonometry    Returns the arccosine of a number 

ACOSH  Math and trigonometry     Returns the inverse hyperbolic cosine of a number 

AGGREGATE  Math and trigonometry     Returns an aggregate in a list or database 

ADDRESS  Lookup and reference     Returns a reference as text to a single cell in a 

worksheet 

AMORDEGRC  Financial    Returns the depreciation for each accounting period 

by using a depreciation coefficient 

AMORLINC  Financial     Returns the depreciation for each accounting period 

AND  Logical     Returns TRUE if all of its arguments are TRUE 

AREAS  Lookup and reference     Returns the number of areas in a reference 

ASC  Text     Changes full-width (double-byte) English letters or 

katakana within a character string to half-width 

(single-byte) characters 

ASIN  Math and trigonometry     Returns the arcsine of a number 

ASINH  Math and trigonometry     Returns the inverse hyperbolic sine of a number 

ATAN  Math and trigonometry    Returns the arctangent of a number 

ATAN2  Math and trigonometry    Returns the arctangent from x- and y-coordinates 

ATANH  Math and trigonometry     Returns the inverse hyperbolic tangent of a number 

AVEDEV  Statistical     Returns the average of the absolute deviations of 

data points from their mean 

AVERAGE  Statistical     Returns the average of its arguments 

AVERAGEA  Statistical     Returns the average of its arguments, including 

numbers, text, and logical values 

AVERAGEIF  Statistical     Returns the average (arithmetic mean) of all the 

cells in a range that meet a given criteria 

AVERAGEIFS  Statistical     Returns the average (arithmetic mean) of all cells 

that meet multiple criteria.  

BAHTTEXT  Text     Converts a number to text, using the ß (baht) 

currency format 

BESSELI  Engineering     Returns the modified Bessel function In(x) 

BESSELJ  Engineering     Returns the Bessel function Jn(x) 

BESSELK  Engineering     Returns the modified Bessel  function Kn(x) 

BESSELY  Engineering    Returns the Bessel function Yn(x) 

BETADIST  Compatibility     Returns the beta cumulative distribution function 

BETA.DIST  Statistical     Returns the beta cumulative distribution function 

BETAINV  Compatibility     Returns the inverse of the cumulative distribution 

function for a specified beta distribution 
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BETA.INV  Statistical    Returns the inverse of the cumulative distribution 
function for a specified beta distribution 

BIN2DEC  Engineering    Converts a binary number to decimal 

BIN2HEX  Engineering     Converts a binary number to hexadecimal 

BIN2OCT  Engineering    Converts a binary number to octal 

BINOMDIST  Compatibility     Returns the individual term binomial distribution 

probability 

BINOM.DIST  Statistical     Returns the individual term binomial distribution 

probability 

BINOM.INV  Statistical     Returns the smallest value for which the cumulative 

binomial distribution is less than or equal to a 

criterion value 

CALL  Add-in and Automation     Calls a procedure in a dynamic link library or code 

resource 

CEILING  Math and trigonometry    Rounds a number to the nearest integer or to the 

nearest multiple of significance 

CEILING.PRECISE  Math and trigonometry     Rounds a number the nearest integer or to the 

nearest multiple of significance. Regardless of the 

sign of the number, the number is rounded up.  

CELL Information    Returns information about the formatting, location, 

or contents of a cell Note, this function is not 

available in Excel Web App. 

CHAR  Text     Returns the character specified by the code number 

CHIDIST  Compatibility     Returns the one-tailed probability of the chi-

squared distribution 

CHIINV  Compatibility     Returns the inverse of the one-tailed probability of 

the chi-squared distribution 

CHITEST  Compatibility     Returns the test for independence 

CHISQ.DIST  Statistical     Returns the cumulative beta probability density 

function 

CHISQ.DIST.RT  Statistical     Returns the one-tailed probability of the chi-

squared distribution 

CHISQ.INV  Statistical     Returns the cumulative beta probability density 

function 

CHISQ.INV.RT  Statistical     Returns the inverse of the one-tailed probability of 

the chi-squared distribution 

CHISQ.TEST  Statistical     Returns the test for independence 

CHOOSE  Lookup and reference     Chooses a value from a list of values 

CLEAN  Text     Removes all nonprintable characters from text 

CODE  Text     Returns a numeric code for the first character in a 

text string 

COLUMN  Lookup and reference     Returns the column number of a reference 

COLUMNS  Lookup and reference     Returns the number of columns in a reference 

COMBIN  Math and trigonometry     Returns the number of combinations for a given 

number of objects 

COMPLEX  Engineering     Converts real and imaginary coefficients into a 

complex number 

CONCATENATE  Text    Joins several text items into one text item 

CONFIDENCE  Compatibility     Returns the confidence interval for a population 

mean 
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CONFIDENCE.NORM  Statistical     Returns the confidence interval for a population 

mean 

CONFIDENCE.T  Statistical     Returns the confidence interval for a population 

mean, using a Student's t distribution 

CONVERT  Engineering     Converts a number from one measurement system 

to another 

CORREL  Statistical     Returns the correlation coefficient between two 

data sets 

COS  Math and trigonometry     Returns the cosine of a number 

COSH  Math and trigonometry     Returns the hyperbolic cosine of a number 

COUNT  Statistical     Counts how many numbers are in the list of 

arguments 

COUNTA  Statistical     Counts how many values are in the list of 

arguments 

COUNTBLANK  Statistical     Counts the number of blank cells within a range 

COUNTIF  Statistical     Counts the number of cells within a range that meet 

the given criteria 

COUNTIFS  Statistical     Counts the number of cells within a range that meet 

multiple criteria 

COUPDAYBS  Financial     Returns the number of days from the beginning of 

the coupon period to the settlement date 

COUPDAYS  Financial     Returns the number of days in the coupon period 

that contains the settlement date 

COUPDAYSNC  Financial     Returns the number of days from the settlement 

date to the next coupon date 

COUPNCD  Financial     Returns the next coupon date after the settlement 

date 

COUPNUM  Financial     Returns the number of coupons payable between 

the settlement date and maturity date 

COUPPCD  

 Financial     Returns the previous coupon date before the 

  settlement date 

COVAR  Compatibility    Returns covariance, the average of the products of 

paired deviations 

COVARIANCE.P  Statistical     Returns covariance, the average of the products of 

paired deviations 

COVARIANCE.S  Statistical     Returns the sample covariance, the average of the 

products deviations for each data point pair in two 

data sets 

CRITBINOM  Compatibility     Returns the smallest value for which the cumulative 

binomial distribution is less than or equal to a 

criterion value 

CUBEKPIMEMBER  Cube     Returns a key performance indicator (KPI) name, 

property, and measure, and displays the name and 

property in the cell. A KPI is a quantifiable 

measurement, such as monthly gross profit or 

quarterly employee turnover, used to monitor an 

organization's performance. 

CUBEMEMBER  Cube    Returns a member or tuple in a cube hierarchy. Use 

to validate that the member or tuple exists in the 

cube. 
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CUBEMEMBERPROPERTY  Cube     Returns the value of a member property in the cube. 

Use to validate that a member name exists within 

the cube and to return the specified property for this 

member. 

CUBERANKEDMEMBER Cube     Returns the nth, or ranked, member in a set. Use to 

return one or more elements in a set, such as the top 

sales performer or top 10 students. 

CUBESET  Cube     Defines a calculated set of members or tuples by 

sending a set expression to the cube on the server, 

which creates the set, and then returns that set to 

Microsoft Office Excel. 

CUBESETCOUNT  Cube     Returns the number of items in a set. 

CUBEVALUE  Cube     Returns an aggregated value from a cube. 

CUMIPMT  Financial     Returns the cumulative interest paid between two 

periods 

CUMPRINC  Financial     Returns the cumulative principal paid on a loan 

between two periods 

DATE Date and time     Returns the serial number of a particular date 

DATEVALUE  Date and time     Converts a date in the form of text to a serial 

number 

DAVERAGE  Database     Returns the average of selected database entries 

DAY  Date and time     Converts a serial number to a day of the month 

DAYS360  Date and time     Calculates the number of days between two dates 

based on a 360-day year 

DB  Financial     Returns the depreciation of an asset for a specified 

period by using the fixed-declining balance method 

DCOUNT  Database     Counts the cells that contain numbers in a database 

DCOUNTA  Database    Counts nonblank cells in a database 

DDB  Financial     Returns the depreciation of an asset for a specified 

period by using the double-declining balance 

method or some other method that you specify 

DEC2BIN  Engineering     Converts a decimal number to binary 

DEC2HEX  Engineering     Converts a decimal number to hexadecimal 

DEC2OCT  Engineering     Converts a decimal number to octal 

DEGREES  Math and trigonometry     Converts radians to degrees 

DELTA  Engineering     Tests whether two values are equal 

DEVSQ  Statistical     Returns the sum of squares of deviations 

DGET  Database     Extracts from a database a single record that 

matches the specified criteria 

DISC  Financial     Returns the discount rate for a security 

DMAX  Database     Returns the maximum value from selected database 

entries 

DMIN  Database     Returns the minimum value from selected database 

entries 

DOLLAR  Text     Converts a number to text, using the $ (dollar) 

currency format 

DOLLARDE  Financial     Converts a dollar price, expressed as a fraction, into 

a dollar price, expressed as a decimal number 

DOLLARFR  Financial     Converts a dollar price, expressed as a decimal 

number, into a dollar price, expressed as a fraction 
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DPRODUCT  Database     Multiplies the values in a particular field of records 

that match the criteria in a database 

DSTDEV  Database     Estimates the standard deviation based on a sample 

of selected database entries 

DSTDEVP  Database     Calculates the standard deviation based on the 

entire population of selected database entries 

DSUM  Database     Adds the numbers in the field column of records in 

the database that match the criteria 

DURATION  Financial     Returns the annual duration of a security with 

periodic interest payments 

DVAR  Database     Estimates variance based on a sample from selected 

database entries 

DVARP  Database     Calculates variance based on the entire population 

of selected database entries 

EDATE  Date and time     Returns the serial number of the date that is the 

indicated number of months before or after the start 

date 

EFFECT  Financial     Returns the effective annual interest rate 

EOMONTH  Date and time     Returns the serial number of the last day of the 

month before or after a specified number of months 

ERF  Engineering     Returns the error function 

ERF.PRECISE  Engineering     Returns the error function 

ERFC  Engineering     Returns the complementary error function 

ERFC.PRECISE  Engineering     Returns the complementary ERF function 

integrated between x and infinity 

ERROR.TYPE  Information     Returns a number corresponding to an error type 

EUROCONVERT  Add-in and Automation     Converts a number to euros, converts a number 

from euros to a euro member currency, or converts 

a number from one euro member currency to 

another by using the euro as an intermediary 

(triangulation). 

EVEN  Math and trigonometry     Rounds a number up to the nearest even integer 

EXACT  Text     Checks to see if two text values are identical 

EXP  Math and trigonometry     Returns e raised to the power of a given number 

EXPON.DIST  Statistical     Returns the exponential distribution 

EXPONDIST  Compatibility    Returns the exponential distribution 

FACT  Math and trigonometry    Returns the factorial of a number 

FACTDOUBLE  Math and trigonometry     Returns the double factorial of a number 

FALSE  Logical     Returns the logical value FALSE 

F.DIST  Statistical     Returns the F probability distribution 

FDIST  Compatibility     Returns the F probability distribution 

F.DIST.RT  Statistical     Returns the F probability distribution 

FIND, FINDB  Text     Finds one text value within another (case-sensitive) 

F.INV  Statistical     Returns the inverse of the F probability distribution 

F.INV.RT  Statistical    Returns the inverse of the F probability distribution 

FINV  Statistical     Returns the inverse of the F probability distribution 

FISHER  Statistical     Returns the Fisher transformation 

FISHERINV  Statistical     Returns the inverse of the Fisher transformation 

FIXED  Text     Formats a number as text with a fixed number of 

decimals 

FLOOR  Math and trigonometry     Rounds a number down, toward zero 
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FLOOR.PRECISE  Math and trigonometry     Rounds a number the nearest integer or to the 

nearest multiple of significance. Regardless of the 

sign of the number, the number is rounded up.  

FORECAST  Statistical     Returns a value along a linear trend 

FREQUENCY  Statistical     Returns a frequency distribution as a vertical array 

F.TEST  Statistical     Returns the result of an F-test 

FTEST  Compatibility      

FV  Financial     Returns the future value of an investment 

FVSCHEDULE  Financial     Returns the future value of an initial principal after 

applying a series of compound interest rates 

GAMMA.DIST  Statistical     Returns the gamma distribution 

GAMMADIST  Compatibility    Returns the gamma distribution 

GAMMA.INV  Statistical     Returns the inverse of the gamma cumulative 

distribution 

GAMMAINV  Compatibility     Returns the inverse of the gamma cumulative 

distribution 

GAMMALN  Statistical    Returns the natural logarithm of the gamma 

function, Γ(x) 

GAMMALN.PRECISE Statistical     Returns the natural logarithm of the gamma 

function, Γ(x) 

GCD  Math and trigonometry    Returns the greatest common divisor 

GEOMEAN  Statistical     Returns the geometric mean 

GESTEP  Engineering     Tests whether a number is greater than a threshold 

value 

GETPIVOTDATA  Add-in and Automation     Returns data stored in a PivotTable report 

GROWTH  Statistical     Returns values along an exponential trend 

HARMEAN  Statistical     Returns the harmonic mean 

HEX2BIN  Engineering     Converts a hexadecimal number to binary 

HEX2DEC  Engineering     Converts a hexadecimal number to decimal 

HEX2OCT  Engineering     Converts a hexadecimal number to octal 

HLOOKUP  Lookup and reference     Looks in the top row of an array and returns the 

value of the indicated cell 

HOUR  Date and time     Converts a serial number to an hour 

HYPERLINK  Lookup and reference     Creates a shortcut or jump that opens a document 

stored on a network server, an intranet, or the 

Internet 

HYPGEOM.DIST  Statistical     Returns the hypergeometric distribution 

HYPGEOMDIST  Compatibility     Returns the hypergeometric distribution 

IF  Logical     Specifies a logical test to perform 

IFERROR  Logical     Returns a value you specify if a formula evaluates 

to an error; otherwise, returns the result of the 

formula 

IMABS  Engineering     Returns the absolute value (modulus) of a complex 

number 

IMAGINARY  Engineering     Returns the imaginary coefficient of a complex 

number 

IMARGUMENT  Engineering     Returns the argument theta, an angle expressed in 

radians 

IMCONJUGATE  Engineering     Returns the complex conjugate of a complex 

number 

IMCOS  Engineering     Returns the cosine of a complex number 
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IMDIV  Engineering    Returns the quotient of two complex numbers 

IMEXP  Engineering     Returns the exponential of a complex number 

IMLN  Engineering     Returns the natural logarithm of a complex number 

IMLOG10  Engineering     Returns the base-10 logarithm of a complex number 

IMLOG2  Engineering     Returns the base-2 logarithm of a complex number 

IMPOWER  Engineering     Returns a complex number raised to an integer 

power 

IMPRODUCT  Engineering    Returns the product of complex numbers 

IMREAL  Engineering     Returns the real coefficient of a complex number 

IMSIN  Engineering     Returns the sine of a complex number 

IMSQRT  Engineering     Returns the square root of a complex number 

IMSUB  Engineering     Returns the difference between two complex 

numbers 

IMSUM  Engineering     Returns the sum of complex numbers 

INDEX  Lookup and reference     Uses an index to choose a value from a reference or 

array 

INDIRECT  Lookup and reference     Returns a reference indicated by a text value 

INFO  Information    Returns information about the current operating 

environment Note: This function is not available in 

Excel Web App. 

INT  Math and trigonometry    Rounds a number down to the nearest integer 

INTERCEPT  Statistical     Returns the intercept of the linear regression line 

INTRATE  Financial     Returns the interest rate for a fully invested security 

IPMT  Financial     Returns the interest payment for an investment for a 

given period 

IRR  Financial     Returns the internal rate of return for a series of 

cash flows 

ISBLANK  Information     Returns TRUE if the value is blank 

ISERR  Information     Returns TRUE if the value is any error value except 

#N/A 

ISERROR  Information     Returns TRUE if the value is any error value 

ISEVEN  Information     Returns TRUE if the number is even 

ISLOGICAL  Information     Returns TRUE if the value is a logical value 

ISNA  Information     Returns TRUE if the value is the #N/A error value 

ISNONTEXT  Information     Returns TRUE if the value is not text 

ISNUMBER  Information     Returns TRUE if the value is a number 

ISODD  Information     Returns TRUE if the number is odd 

ISREF  Information     Returns TRUE if the value is a reference 

ISTEXT  Information     Returns TRUE if the value is text 

ISO.CEILING  Math and trigonometry     Returns a number that is rounded up to the nearest 

integer or to the nearest multiple of significance 

ISPMT  Financial     Calculates the interest paid during a specific period 

of an investment 

JIS  Text     Changes half-width (single-byte) English letters or 

katakana within a character string to full-width 

(double-byte) characters 

KURT  Statistical     Returns the kurtosis of a data set 

LARGE  Statistical     Returns the k-th largest value in a data set 

LCM  Math and trigonometry     Returns the least common multiple 

LEFT, LEFTB functions Text     Returns the leftmost characters from a text value 

LEN, LENB functions Text     Returns the number of characters in a text string 
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LINEST  Statistical     Returns the parameters of a linear trend 

LN  Math and trigonometry     Returns the natural logarithm of a number 

LOG  Math and trigonometry     Returns the logarithm of a number to a specified 

base 

LOG10  Math and trigonometry     Returns the base-10 logarithm of a number 

LOGEST  Statistical     Returns the parameters of an exponential trend 

LOGINV  Compatibility     Returns the inverse of the lognormal cumulative 

distribution 

LOGNORM.DIST  Statistical     Returns the cumulative lognormal distribution 

LOGNORMDIST  Compatibility    Returns the cumulative lognormal distribution 

LOGNORM.INV  Statistical     Returns the inverse of the lognormal cumulative 

distribution 

LOOKUP  Lookup and reference     Looks up values in a vector or array 

LOWER  Text     Converts text to lowercase 

MATCH  Lookup and reference     Looks up values in a reference or array 

MAX  Statistical     Returns the maximum value in a list of arguments 

MAXA  Statistical     Returns the maximum value in a list of arguments, 

including numbers, text, and logical values 

MDETERM  Math and trigonometry     Returns the matrix determinant of an array 

MDURATION  Financial     Returns the Macauley modified duration for a 

security with an assumed par value of $100 

MEDIAN  Statistical     Returns the median of the given numbers 

MID, MIDB functions Text     Returns a specific number of characters from a text 

string starting at the position you specify 

MIN  Statistical     Returns the minimum value in a list of arguments 

MINA  Statistical     Returns the smallest value in a list of arguments, 

including numbers, text, and logical values 

MINUTE  Date and time     Converts a serial number to a minute 

MINVERSE  Math and trigonometry     Returns the matrix inverse of an array 

MIRR  Financial     Returns the internal rate of return where positive 

and negative cash flows are financed at different 

rates 

MMULT  Math and trigonometry     Returns the matrix product of two arrays 

MOD  Math and trigonometry     Returns the remainder from division 

MODE  Compatibility     Returns the most common value in a data set 

MODE.MULT  Statistical     Returns a vertical array of the most frequently 

occurring, or repetitive values in an array or range 

of data 

MODE.SNGL  Statistical     Returns the most common value in a data set 

MONTH  Date and time     Converts a serial number to a month 

MROUND  Math and trigonometry     Returns a number rounded to the desired multiple 

MULTINOMIAL  Math and trigonometry     Returns the multinomial of a set of numbers 

N  Information     Returns a value converted to a number 

NA  Information     Returns the error value #N/A 

NEGBINOM.DIST  Statistical     Returns the negative binomial distribution 

NEGBINOMDIST  Compatibility     Returns the negative binomial distribution 

NETWORKDAYS  Date and time     Returns the number of whole workdays between 

two dates 

NETWORKDAYS.INTL Date and time     Returns the number of whole workdays between 

two dates using parameters to indicate which and 

how many days are weekend days 
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NOMINAL  Financial     Returns the annual nominal interest rate 

NORM.DIST  Statistical     Returns the normal cumulative distribution 

NORMDIST  Compatibility     Returns the normal cumulative distribution 

NORM.INV  Statistical     Returns the inverse of the normal cumulative 

distribution 

NORMINV  Compatibility     Returns the inverse of the normal cumulative 

distribution 

NORM.S.DIST  Statistical     Returns the standard normal cumulative distribution 

NORMSDIST  Compatibility     Returns the standard normal cumulative distribution 

NORM.S.INV  RStatistical     Returns the inverse of the standard normal 

cumulative distribution 

NORMSINV  Compatibility     Returns the inverse of the standard normal 

cumulative distribution 

NOT  Logical     Reverses the logic of its argument 

NOW  Date and time     Returns the serial number of the current date and 

time 

NPER  Financial     Returns the number of periods for an investment 

NPV  Financial     Returns the net present value of an investment 

based on a series of periodic cash flows and a 

discount rate 

OCT2BIN  Engineering     Converts an octal number to binary 

OCT2DEC  Engineering     Converts an octal number to decimal 

OCT2HEX  Engineering     Converts an octal number to hexadecimal 

ODD  Math and trigonometry     Rounds a number up to the nearest odd integer 

ODDFPRICE  Financial     Returns the price per $100 face value of a security 

with an odd first period 

ODDFYIELD  Financial     Returns the yield of a security with an odd first 

period 

ODDLPRICE  Financial     Returns the price per $100 face value of a security 

with an odd last period 

ODDLYIELD  Financial     Returns the yield of a security with an odd last 

period 

OFFSET  Lookup and reference     Returns a reference offset from a given reference 

OR  Logical     Returns TRUE if any argument is TRUE 

PEARSON  Statistical     Returns the Pearson product moment correlation 

coefficient 

PERCENTILE.EXC Statistical     Returns the k-th percentile of values in a range, 

where k is in the range 0..1, exclusive 

PERCENTILE.INC  Statistical     Returns the k-th percentile of values in a range 

PERCENTILE  Compatibility     Returns the k-th percentile of values in a range 

PERCENTRANK.EXC  Statistical    Returns the rank of a value in a data set as a 

percentage (0..1, exclusive) of the data set 

PERCENTRANK.INC  Statistical     Returns the percentage rank of a value in a data set 

PERCENTRANK  Compatibility     Returns the percentage rank of a value in a data set 

PERMUT  Statistical     Returns the number of permutations for a given 

number of objects 

PHONETIC  Text     Extracts the phonetic (furigana) characters from a 

text string 

PI  Math and trigonometry     Returns the value of pi 

PMT  Financial     Returns the periodic payment for an annuity 

POISSON.DIST  Statistical     Returns the Poisson distribution 
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POISSON  Compatibility     Returns the Poisson distribution  

POWER  Math and trigonometry     Returns the result of a number raised to a power 

PPMT  Financial     Returns the payment on the principal for an 

investment for a given period 

PRICE  Financial     Returns the price per $100 face value of a security 

that pays periodic interest 

PRICEDISC  Financial     Returns the price per $100 face value of a 

discounted security 

PRICEMAT  Financial     Returns the price per $100 face value of a security 

that pays interest at maturity 

PROB  Statistical     Returns the probability that values in a range are 

between two limits 

PRODUCT  Math and trigonometry     Multiplies its arguments 

PROPER  Text     Capitalizes the first letter in each word of a text 

value 

PV  Financial     Returns the present value of an investment 

QUARTILE  Compatibility     Returns the quartile of a data set 

QUARTILE.EXC  Statistical     Returns the quartile of the data set, based on 

percentile values from 0..1, exclusive 

QUARTILE.INC  Statistical     Returns the quartile of a data set 

QUOTIENT  Math and trigonometry    Returns the integer portion of a division 

RADIANS  Math and trigonometry     Converts degrees to radians 

RAND  Math and trigonometry    Returns a random number between 0 and 1 

RANDBETWEEN  Math and trigonometry     Returns a random number between the numbers 

you specify 

RANK.AVG  Statistical     Returns the rank of a number in a list of numbers  

RANK.EQ  Statistical     Returns the rank of a number in a list of numbers 

RANK  Compatibility     Returns the rank of a number in a list of numbers 

RATE  Financial     Returns the interest rate per period of an annuity 

RECEIVED  Financial     Returns the amount received at maturity for a fully 

invested security 

REGISTER.ID  Add-in and Automation     Returns the register ID of the specified dynamic 

link library (DLL) or code resource that has been 

previously registered 

REPLACE, REPLACEB  Text     Replaces characters within text 

REPT  Text     Repeats text a given number of times 

RIGHT, RIGHTB  Text     Returns the rightmost characters from a text value 

ROMAN  Math and trigonometry    Converts an Arabic numeral to roman, as text 

ROUND  Math and trigonometry     Rounds a number to a specified number of digits 

ROUNDDOWN Math and trigonometry     Rounds a number down, toward zero 

ROUNDUP  Math and trigonometry     Rounds a number up, away from zero 

ROW  Lookup and reference     Returns the row number of a reference 

ROWS  Lookup and reference     Returns the number of rows in a reference 

RSQ  Statistical     Returns the square of the Pearson product moment 

correlation coefficient 

RTD  Lookup and reference     Retrieves real-time data from a program that 

supports COM automation 

SEARCH, SEARCHB  Text     Finds one text value within another (not case-

sensitive) 

SECOND  Date and time     Converts a serial number to a second 
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SERIESSUM  Math and trigonometry     Returns the sum of a power series based on the 

formula 

SIGN  Math and trigonometry     Returns the sign of a number 

SIN  Math and trigonometry     Returns the sine of the given angle 

SINH  Math and trigonometry     Returns the hyperbolic sine of a number 

SKEW  Statistical     Returns the skewness of a distribution 

SLN  Financial     Returns the straight-line depreciation of an asset for 

one period 

SLOPE  Statistical     Returns the slope of the linear regression line 

SMALL  Statistical     Returns the k-th smallest value in a data set 

SQL.REQUEST  Add-in and Automation     Connects with an external data source and runs a 

query from a worksheet, then returns the result as 

an array without the need for macro programming 

SQRT  Math and trigonometry     Returns a positive square root 

SQRTPI  Math and trigonometry    Returns the square root of (number * pi) 

STANDARDIZE  Statistical     Returns a normalized value 

STDEV  Compatibility     Estimates standard deviation based on a sample 

STDEV.P  Statistical     Calculates standard deviation based on the entire 

population  

STDEV.S  Statistical     Estimates standard deviation based on a sample 

STDEVA  Statistical     Estimates standard deviation based on a sample, 

including numbers, text, and logical values 

STDEVP  Compatibility     Calculates standard deviation based on the entire 

population 

STDEVPA  Statistical     Calculates standard deviation based on the entire 

population, including numbers, text, and logical 

values 

STEYX  Statistical     Returns the standard error of the predicted y-value 

for each x in the regression 

SUBSTITUTE  Text     Substitutes new text for old text in a text string 

SUBTOTAL  Math and trigonometry    Returns a subtotal in a list or database 

SUM  Math and trigonometry     Adds its arguments 

SUMIF  Math and trigonometry     Adds the cells specified by a given criteria 

SUMIFS  Math and trigonometry     Adds the cells in a range that meet multiple criteria 

SUMPRODUCT  Math and trigonometry     Returns the sum of the products of corresponding 

array components 

SUMSQ  Math and trigonometry     Returns the sum of the squares of the arguments 

SUMX2MY2  Math and trigonometry     Returns the sum of the difference of squares of 

corresponding values in two arrays 

SUMX2PY2  Math and trigonometry     Returns the sum of the sum of squares of 

corresponding values in two arrays 

SUMXMY2  Math and trigonometry     Returns the sum of squares of differences of 

corresponding values in two arrays 

SYD  Financial     Returns the sum-of-years' digits depreciation of an 

asset for a specified period 

T  Text     Converts its arguments to text 

TAN  Math and trigonometry     Returns the tangent of a number 

TANH  Math and trigonometry     Returns the hyperbolic tangent of a number 

TBILLEQ  Financial     Returns the bond-equivalent yield for a Treasury 

bill 
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TBILLPRICE  Financial     Returns the price per $100 face value for a Treasury 

bill 

TBILLYIELD  Financial     Returns the yield for a Treasury bill 

T.DIST  Statistical     Returns the Percentage Points (probability) for the 

Student t-distribution 

T.DIST.2T  Statistical     Returns the Percentage Points (probability) for the 

Student t-distribution 

T.DIST.RT  Statistical     Returns the Student's t-distribution 

TDIST  Compatibility     Returns the Student's t-distribution 

TEXT  Text     Formats a number and converts it to text 

TIME  Date and time     Returns the serial number of a particular time 

TIMEVALUE  Date and time     Converts a time in the form of text to a serial 

number 

T.INV  Statistical     Returns the t-value of the Student's t-distribution as 

a function of the probability and the degrees of 

freedom 

T.INV.2T  Statistical     Returns the inverse of the Student's t-distribution 

TINV  Compatibility     Returns the inverse of the Student's t-distribution 

TODAY  Date and time     Returns the serial number of today's date 

TRANSPOSE  Lookup and reference     Returns the transpose of an array 

TREND  Statistical     Returns values along a linear trend 

TRIM  Text     Removes spaces from text 

TRIMMEAN  Statistical     Returns the mean of the interior of a data set 

TRUE  Logical     Returns the logical value TRUE 

TRUNC  Math and trigonometry     Truncates a number to an integer 

T.TEST  Statistical     Returns the probability associated with a Student's 

t-test 

TTEST  Compatibility     Returns the probability associated with a Student's 

t-test 

TYPE  Information     Returns a number indicating the data type of a 

value 

UPPER  Text     Converts text to uppercase 

VALUE  Text     Converts a text argument to a number 

VAR  Compatibility     Estimates variance based on a sample 

VAR.P  Statistical     Calculates variance based on the entire population 

VAR.S  Statistical     Estimates variance based on a sample 

VARA  Statistical     Estimates variance based on a sample, including 

numbers, text, and logical values 

VARP  Compatibility     Calculates variance based on the entire population 

VARPA  Statistical     Calculates variance based on the entire population, 

including numbers, text, and logical values 

VDB  Financial     Returns the depreciation of an asset for a specified 

or partial period by using a declining balance 

method 

VLOOKUP  Lookup and reference     Looks in the first column of an array and moves 

across the row to return the value of a cell 

WEEKDAY  Date and time     Converts a serial number to a day of the week 

WEEKNUM  Date and time     Converts a serial number to a number representing 

where the week falls numerically with a year 

WEIBULL  Compatibility     Calculates variance based on the entire population, 

including numbers, text, and logical values 
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WEIBULL.DIST  Statistical     Returns the Weibull distribution 

WORKDAY  Date and time     Returns the serial number of the date before or after 

a specified number of workdays 

WORKDAY.INTL  Date and time     Returns the serial number of the date before or after 

a specified number of workdays using parameters 

to indicate which and how many days are weekend 

days 

XIRR  Financial     Returns the internal rate of return for a schedule of 

cash flows that is not necessarily periodic 

XNPV  Financial     Returns the net present value for a schedule of cash 

flows that is not necessarily periodic 

YEAR  Date and time     Converts a serial number to a year 

YEARFRAC  Date and time     Returns the year fraction representing the number 

of whole days between start_date and end_date 

YIELD  Financial     Returns the yield on a security that pays periodic 

interest 

YIELDDISC  Financial     Returns the annual yield for a discounted security; 

for example, a Treasury bill  

YIELDMAT  Financial     Returns the annual yield of a security that pays 

interest at maturity 

Z.TEST  Statistical     Returns the one-tailed probability-value of a z-test 

ZTEST  Compatibility     Returns the one-tailed probability-value of a z-test 

 

 

 

Placing a Function in Your Spreadsheet 
Excel has hundreds of built-in functions. Functions always consist of 3 parts the equal sign, the function's 

name (this includes parentheses), and the argument(s).    

Functions can be entered in one of three ways 

typed entirely, using the mouse only with the 

Function command to the left of the edit  bar, or a 

combination of typing and clicking the mouse.  

The most common function is the Sum function.  

Excel has a shortcut button located on the home 

tab that makes this very easy to enter.  To use the 

shortcut button, select the range to be summed and 

the cell where the formula should be and click on 

the Sum shortcut button.  To enter a function, 

move to the correct cell and either type its name 

starting with an equal sign or click on the function 

command located to the left of the edit bar. Scroll 

down through the previously used functions or 

type the name of the function in the search window 

of the insert function dialog box.  Enter the 

argument(s) between the parentheses.  While the argument(s) can be typed, it is safer and more accurate 

to use the mouse to either point or drag through desired cell(s).  A large list of the functions included in 

Excel is listed above. 
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Editing a Worksheet 
An Excel worksheet can be modified to add or subtract rows, columns, or cells.  Ranges of a worksheet 

can be copied or moved to another location without destroying the formulas already entered.  The column 

width or row height may also be adjusted to accommodate the data being entered into cells. 

 

Inserting/Deleting Rows or Columns or Cells 

 To insert rows, cells, or columns into a worksheet, select the desired area and 

choose Insert from the cells group on the Home tab.  Excel will insert the cells 

above rows and to the left of columns. 

 To delete column(s), row(s), or cell(s) from a worksheet, select the desired cells 

and choose Delete from the cells group on the Home tab. 

 

Copying/Moving Cells in a Worksheet 

 To copy cells in a worksheet, select the desired cells and choose Copy from the 

Clipboard group in the Home tab or ribbon.  Move to the desired location 

and choose Paste from the Clipboard group in the Home tab or ribbon (If a 

range of cells is being copied, it is only necessary to select the top left hand 

corner of the location the cells will be copied to). 

 To move cells in a worksheet, select the desired cells and choose Cut Copy 

from the Clipboard group in the Home tab or ribbon.  Move to the new 

location and choose Paste Copy from the Clipboard group in the Home tab 

or ribbon (Only the top left corner needs to be selected).   

 

Paste Special 
A very important point regarding copying cells is the fact that 

formulas will be written as a relative reference.  If you have 

answers calculated by formulas and copy the answers to another 

portion of the sreadsheet, your answers will change because the 

formulas that obtained the original answers will be re-writtent to 

take into account the new location on the spreadsheet.  If you itend 

on using just the answers (no 

formula), use the Paste Special 

command from the Clipboard group in the Home tab or ribbon. 

 

 

 

Adjusting Column Width/Row Height 

 The width or height of columns and rows can be adjusted with the 

mouse or through the menus.   

 To adjust the width or height with the mouse, move the mouse pointer 

on to the border between two columns or rows (The mouse will turn 

to a double pointed arrow.)  When it changes, drag to the desired 

location.   

 To adjust the width using the menus, select the desired 

column(s)/row(s) and Format in the Cells group, on the Home Tab.  

Type the desired amount in the resulting dialog box. 
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 You may have Excel format the width of a column or height of a row automatically by double 

clicking the intersection of a row or column. 

Formatting a Worksheet or Cells 
Formatting a worksheet may involve adding number formats, such as dollar 

signs and commas, text attributes, such as bold, point size, etc., the alignment 

of information in the cell, and borders in the cell(s). 

 

To format a cell or range of cells, select the cell(s) and choose the 

appropriate choice in the Format Menu or click on the appropriate button(s) 

in the Shortcut floating palette.  

Printing a Worksheet 
A worksheet can be printed by choosing Print in the File Menu.  However, what the Print command 

produces will be influenced by choices that have been set in other commands. 

 

The Page Setup group in the Page Layout Tab, determines the basic page layout (landscaped vs. 

portrait).  Most other page setup commands allow you to determining if the gird,  row and column 
headings print and if you wish to print part of a spreadsheet through the Print Area command.   

 

Modifying the Quick Access Toolbar 
The Quick Access Toolbar provides a place to access the most common commands you will use with 

Word 2010. You may customize this toolbar to provide quick access to what items you commonly use. 

From the File Tab, Choose Options, then Quick Access Toolbar. You can add or delete as many items 
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you wish to this easy toolbar to hold your most used commands. Simply move items left or right between 

the two windows. 

 

 

 

 

 

 

 

 

Graphing (Charting) a Worksheet 
A graph or chart is a pictorial view of a spreadsheet.  Excel has over 12 built-in charts that can quickly be 

applied to any section of a worksheet.  Excel has the capacity to produce bar, area, line, scatter, pie, 

pictogram, stacked bar, stacked area, X-Y line, X-Y scatter, hi-low, stacked pictogram and combination 

charts. Once created a chart is linked to the worksheet (unless it is copied and pasted into another 

document).  If the numbers in the worksheet are changed, the chart will immediately reflect the changes.  

In addition to the formatting that is done when creating a chart, the chart can be modified by using the 

draw tools. 

 

To create a chart, select the desired range of cells to be selected.  Then choose Chart from the Insert Menu 

or click on the appropriate button on the shortcuts palette.  The chart can be modified by double clicking 

on the chart or by choosing to modify it from the menu to get the Chart Options dialog box.   

 

When Excel creates a new chart, it automatically graphs the data by rows in the cell selection so the 

column headings appear along the horizontal (category) axis at the bottom of the chart and the row 

headings appear in the legend. To change this convention, you may click the Switch Row/Columns button 

in the Data Group when clicked on a chart. 

Charting Terminology 
 

Part of Chart Description 

Chart Area Everything inside the chart window including all parts of the chart such as labels, 

axes, data markers, tick marks, etc. 

Data Marker A symbol on the chart that represents a single value in the spreadsheet. A symbol 

may be a bar in a bar chart, or a line on a line chart. Data markers with the same 

shape/pattern represent a single data series in the chart 

Chart Data Series A group of related values such as all the values in a single row in the chart. A 

chart can have just one data series, but usually has more. 
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Series Formula A formula describing a given data series. The formula will include a reference cell 

that contains the data series name, references to worksheet cells containing the 

categories and values plotted in the chart, and the plot order of the series. The 

series formula can also have the actual data used to plot the chart. You can edit a 

series formula and control the plot area. 

Axis A line that serves as a major reference for plotting data on a chart. Two 

dimensional charts have two axes. They would be the “X” – horizontal category 

axis, and the “Y” – vertical category axis. Excel follows pre-programmed rules 

when plotting charts. In most 2 dimensional charts, Excel plots categories (labels) 

along the “X” axis and values (numbers) along the “Y” axis. Pie charts do not 

have axes. 3 Dimensional charts have and X, Y and Z axis. The X and Y plot the 

surface data while the Z axis plots the depth of the third dimension of the chart. 

Tick Mark A small line runing at right angles to an axis. This mark indicates a category scale 

or a chart data series. Tick marks may be labeled. 

Plot Area This is the area Excel uses to plot the data. It includes all the axes, markers, and 

data points. 

Gridlines These represent optional lines that extend vertically and/or horizontally from tick 

marks. These allow you to view the value data plotted on the chart. 

Chart Text This is a title or label the user adds to a chart. Chart text may also be added with a 

text box. 

Legend This is a key used to identify data in a chart.  

Sparkline Invented by Edward Tufte – tiny graphs that represents trends or changes in your 

data. They are very small, almost thumb nail charts shown near your data. 

 

Working with Charts 
After entering data in a spreadsheet, a simple chart can be made by highlighting the data and selecting a 

chart type in the chart group located on the Insert Ribbon. After you create a chart, click on it and the 

Chart Tools Tab will appear. This tab consists of three parts, Design, Layout, and Format. 

 

Chart Tools - Design 

While in the Chart Tools – Design, you are able to click on following buttons located in different groups 

in the ribbon. 

 

 Change Chart Type in the Type Group – This button allows you to change the type of chart 

you made.  

 Save As Template in the Type Group - This button allows you to save the current chart’s 

formatting and layout to be used as a template for creating future charts with those same 

attributes. 

 Switch Row/Columns in the Data Group - This button allows you to interchange worksheet 

data used for the Legend Entries (the series) with that used for the Axis Labels (categories) in the 

current selected chart. 
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 Select Data in the Data Group - This button allows you to interchange worksheet data used for 

the Legend Entries (the series) with that used for the Axis Labels (categories) but also edit out or 

add entries to either category. When you click the Select Data button from the Design tab of the 

Chart Tools contextual tab, the Edit Data Source dialog box opens. The controls in this dialog 

box enable you to make these changes to the source data: 

 

 1. Modify the range of data graphed in your chart by clicking the Chart Data Range text box and 

then making a new cell selection in the worksheet, or typing in a new range of data. 

 2. Switch the row and column headings back and forth by clicking the Switch Row/Column button. 

 3. Edit the labels used to identify the data series in the legend or on the horizontal (Category) by 

clicking the edit button on the Legend Entries (Series) or Horizontal (Categories) Axis Labels side 

and then selecting the cell range with appropriate row or column headings in the worksheet. 

 4. Add additional data series to the chart by clicking the Add button on the Legend Entries (Series) 

side and then selecting the cell containing the heading for that series in the series Name text box 

and the cell containing the values to be graphed in that series in the Series Values text box. 

 5. Delete a label from the legend by clicking its name in the legend entries (Series), list box, and then 

clicking the Remove button. 

 6. Modify the order of the data series in the chart by clicking the series name in the Legend Entries 

(Series) list box and then clicking the Move Up or Move Down button until the data series appears 

on the correct position in the chart. 

 7. Configure how to deal with empty cells in the data range being graphed by clicking the Hidden 

and Empty Cells button and selecting the appropriate Show Empty Cells As option button (Gaps, 

Zero and Span with Line, for line charts). Click the show hidden rows and Columns box to make 

Excel graph data in the hidden rows and columns within the selected cell range. 
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 Chart Layouts Group – When clicking on the more button (right of the three buttons in this 

group) displays all the thumbnails of the new layout style you wish to apply to the selected chart. 

 Chart Styles Group – Click the more styles button to the right of the styles shown to display the 

thumbnails of the new chart styles you wish to apply to the selected chart. 

 Move Chart in the Location Group – This button allows you to move an embedded chart to its 

own chart or move a chart on its own sheet to one of the worksheets in the workbook as an 

embedded chart.  

 

Chart Tools – Layout 

 

Customizing Your Chart From the Layout Tab 
 

Tab Group Option Name Purpose 

Current Selection Chart Elements This combo box shows the name of the element currently 

selected in the chart and enables you to select a new 

element in the current chart 

 Format Selection Opens a format dialog bix for the currentyl selected chart 

element that you can use to modify format 

 Reset to Match Style Resets any formatting changes made to the currently 

selected chart element to match the style selected for the 

chart 

Insert Picture This command’s button drop-down menu enables you to 

add a pictured saved to your hard drive or one of the 

graphics that come with the Microsoft programs 

 Shapes This command’s button drop-down menu enables you to 

add any preset graphic shapes to a chart 

 Text Box This command’s button drop-down menu enables you to 

add a horizontal or vertical text box to a chart 

Labels Chart Title This command’s button drop-down menu enables you to 

add a chart title centered above a chart, centered above of 

a chart plot area, or remove a chart title 

 Axis Title This command’s button drop-down menu enables you to 

add, reposition, or remove the chart’s horizontal (category) 

axis titles or vertical (value) axis title 

 Legend This command’s button drop-down menu enables you to 

add, position, or remove the legend from the chart 

 Data Lables This command’s button drop-down menu enables you to 

add, position, or remove labels that identify each data 

series represented in the chart 

 Data Table This command’s button drop-down menu enables you to 
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add, position, or remove a data table beneath the chart that 

displays the values graphed in the chart 

Axes Axes This command’s button drop-down menu enables you to 

reposition, reformat, or remove the chart’s horizontal 

(category) axis titles and vertical (value) axis 

 Gridlines This command’s button drop-down menu enables you to 

display or hide horizontal or vertical grid lines in the chart 

area 

Background Plot Area This command’s button drop-down menu enables you to 

remove the plot area background or redisplay it 

 Cart Wall This command’s button drop-down menu enables you to 

clear or redisplay a 3-D chart’s back walls 

 Chart Floor This command’s button drop-down menu enables you to 

clear or redisplay a 3-D chart’s floor 

 3-D Rotation This command’s button drop-down menu enables you to 

open the format Chart Area dialog box for a 3-D chart 

where you can modify a large number of aspects of the 

chart including its 3-D shadow and rotation 

Analysis Trendline This command’s button drop-down menu enables you to 

display or hide linear, exponential, linear forecast, or two 

period moving average trend lines that display a trend 

implied by the charted data. Trendlines are often added to 

XY Scatter charts that correlate two different sets of 

numerical data to graphically point out the correlation 

between two sets. 

 Lines This command’s button drop-down menu enables you to 

display or hide drop lines on a 2-D or 3-D line or area 

chart that connect related values as well as high-low lines 

on a 2-D line chart that emphasize the high and low values 

in the chart 

 Up/Down Bars This command’s button drop-down menu enables you to 

display or hide up/down bars in the chart that emphasize 

the high and low values in the chart 

 Error Bars This command’s button drop-down menu enables you to 

display or hide error bars with standard error, error bars 

with percentage, or error bars with deviation that show 

how much the data markers are above or below a 

particular value, percentage, or standard deviation in the 

chart 

Properties Chart Properties The chart name box shows you the generic name of the 

selected chart and allows you to edit or replace it with a 

name you choose 
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Chart Tools - Format 
 

 

Customizing Your Chart from the Format Tab 
 

Tab Group Option Name Purpose 

Current Selection Chart Elements Click this command button to select a new chart element by 

clicking its name on the button’s drop-down menu 

 Format Selection Click this command button to open a format dialog box for 

the currently selected chart element as displayed on the 

chart Elements drop-down list button 

 Reset to Match 

Style 

Click this command button to remove all custom formatting 

from the selected chart and to return it to the original 

formatting bestowed by the style selected for the chart 

Shape Styles Shape Styles Click the Shape Styles’ More button to display a drop-

down gallery in from which you can preview and select 

new shapes and colors for the currently selected chart 

element as displayed on the Chart Elements drop-down list 

 Shape Fill Click this command button to display a drop-down color 

palette from which you can preview selected chart elements 

as displayed on the Chart Elements drop-down list 

 Shape Outline Click this command button to display a drop-down color 

palette from which you can preview and select an outline 

color for the currently selected element as displayed on the 

Chart Elements drop-down list 

 Shape Effects Click this button to display a drop-down menu listing an 

array of graphic effect options to be applied to the element 

displayed on the Chart Elements drop-down list 

WordArt Styles WordArt Styles Click the WordArt Styles button to display a drop-down 

gallery in from which you can preview and select a new 

WordArt gallery to the currently selected element as 

displayed on the Chart Elements drop-down list 

 Text Fill Click this button to display a drop-down list from which 

you can preview and select a new text fill color to be 

applied to the element displayed on the Chart Elements 

drop-down list 

 Text Outline Click this button to display a drop-down list from which 

you can preview and select a new text outline color to be 

applied to the element displayed on the Chart Elements 

drop-down list 

 Text Effects Click this button to display a drop-down list from which 

you can preview and select a new text effect to be applied 

to the element displayed on the Chart Elements drop-down 

list 
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Arrange Bring Forward Click this button to move an object to a higher level in the 

stack (moving it closer to your face) or click Bring Front to 

move the object to the top of the stack 

 Send Backward Click this button to move an object to a lower level in the 

stack (moving it away from your face) or click Send to 

Back to move the object to the bottom of the stack 

 Selection Pane Click this button to display and hide the Selection and 

Visibility task pane that shows all the graphic objects on the 

page. This enables you to hide or display the objects as wel 

as move them in the stack. This command only works if 

two or more objects in the spreadsheet are selected 

 Align Click this button to display a drop-down list from which 

you can snap the selected chart to an invisble grid on 

another graphic object as well as choose between a number 

of alighnments of selected objects 

 Group After selecting at least two objects, clicking this button will 

allow you to combine multiple objects to be treated as one 

 Rotate After selecting at least one object, this command will allow 

you to rotate or flip the selected object 

Size Shape Height After selecting at least one object, this command will allow 

you to change the height of an object by typing in a value 

or choosing one from a spinner button 

 Shape Width After selecting at least one object, this command will allow 

you to change the width of an object by typing in a value or 

choosing one from a spinner button 

Sort and Filter Group in the Data Tab 
The Data tab allows you to manipulate data in your spreadsheet. Many of the options are beyond the first 

level of the Excel class but are covered in the advanced class. Like a database, the information in a 

spreadsheet may be sorted. To sort a spreadsheet or part of a spreadsheet, select the desired range of data 

and choose Sort in the Sort and Filter Group in the Data Tab.  You may use up to 3 keys to sort a 

selected range. In the example below, I selected all columns of the data. After clicking the sort button, the 

sort dialog menu appears. There will be one line 

with drop down boxes to fill in your choices. I 

told Excel to sort by column A in the 

spreadsheet. This put all the satellite passes in 

chronological order from the oldest to the 

newest date. I also wanted the satellite passes 

sorted by the time the satellite passes my house. 

I added another level and chose Column H 

which is the AOS or Acquisition of Signal time. 

The sorted list shows mw what satellites pass 

each day as well as when they pass according to 

the time through the day. 

 

You may wish to filter specific data in a 

spreadsheet. If I wished to pull one or more 

satellites out of the above list I can keep the data 

highlighted and click on the filter command button in the Sort and Filter Group in the Data Tab.  In the 
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following example, I chose to pull out just the International Space Station (ISS) as well as the NOAA 19 

weather satellite. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Add-Ins that come with Excel 
After adding Excel to your computer, there are some features you may use after they are installed. 
 

 Analysis ToolPak – Adds extra financial, engineering, and statistical functions to your 
spreadsheets. 

 Analysis ToolPak VBA – Allows VBA programmers to publsih their own financial, engineering, 
and statistical functions  for Excel. 

 Euro Currency Tools – You may format worksheet values as euro currency and adds a 
euroconvert function for converting other currencies into euros. 

 Solver Add-In – Calculates solutions to what-if scenarios based on cells that both adjust and 
constrain the range of values. 

Adding the Add-Ins 

To incorporate any of the add-Ins provided by 

Microsoft, choose from the file Tab, Options, then 

Add-Ins. The following dialog box allows you to 

choose items you wish to use. 
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Microsoft Excel Assignments 
In addition to the practice spreadsheets completed in class, the following assignments will be completed: 

 
 Outside Classroom Assignment #1 
  1. Create a sample spreadsheet similar to our multiplication table. 

  2. Use the fill down and fill right commands along with at least one function (formula). 

  3. Format labels in the spreadsheet using different fonts, point values, styles, and colors. 

  4. Create borders in different areas of the spreadsheet. 

  5. Make sure you vary some row heights and column widths. 

  6.  Include your name in the footer of your document. 

  7. Do not exceed one page in length, have at least 20 rows of data, and at least 4 columns of 

data. 

 
 Outside Classroom Assignment #2 
  1. Create a spreadsheet to track student grades. 

  2. The spreadsheet must contain at least 15 students. 

  3. The spreadsheet must contain 8 different assignments for each student. 

  4. The point value of each assignment must be different. 

  5. The spreadsheet must calculate the percent of points the student earned compared to the 

points possible for the entire class. 

  6. Using a lookup table, make the spreadsheet calculate the letter grade for each student based 

on their grade percent. 

  7. Spice up your spreadsheet with borders, color, and different fonts and styles. 

  8. Include your name in the footer of your document. 

 
 Outside Classroom Assignment #3 
  1. Download yearly data for 4 different stocks from the Yahoo financial website. 

(http://www.yahoo.com). 

  2. Convert the data to spreadsheet format. 

  3. Create a line chart comparing the four stock prices as line graphs using different colors. 

  4. Make sure the legend in the chart specifies the names of the four stocks. 

  5. Make a hard copy (print) of your chart. It is not necessary to print your spreadsheet data. 

  6. Include your name in the footer of your document (chart). 

 

 Outside Classroom Assignment #4 
  1. Create an independent project spreadsheet that can be used in your classroom. 

  2. Use relative and absolute cell addressing. 

  3. Use various fonts and styles in your labels. 

  4. Make sure you format values specific to what they represent in your spreadsheet. 

  5. Vary column widths and row heights. 

  6. Create a chart to show the results of your spreadsheet. 

  7. Print the spreadsheet and chart. Include your name in the footer of your document. 

 

 Outside Classroom Assignment #5 
  1. Complete your independent project with instructor’s assistance and supervision. 

  2. Share independent projects with the participants in class. 
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Using Microsoft Excel Class Outline
 

Introduction: 

 Who am I - background - where and what I 

teach/taught 

 How to contact me 

 Handouts - reference documents 

 Outside assignments 

 Act 48 credit - attendance and assignments 

 Name tags 

 Break time 

 Bathrooms 

 Start and end of class time 

 

Items Covered during the class: 

 What is Excel?  What is new in 2010? 

 What is new in 2010? 

 Getting around the harddrive - using 

Windows Explorer 

 Closing, re-sizing, minimize, maximize, the 

task bar 

 Viewing menus 

 Left and right mouse buttons 

 Moving, copying, renaming, and deleting 

files 

 Creating personal folders for your files 

 Download files from my website 

 Unzipping and placing my files in the 

correct folder(s) 

 Running the Excel application 

 How we load multiple files into Excel 

 Open sample files - Demos using various 

files to show the capabilities of Excel 

 Open a new spreadsheet workbook 

 Cursor moves, return, arrows, tab, shift-tab, 

shift-return 

 Entering labels in cells - right cell not filled 

and filled 

 Entering values in cells - right cell not filled 

and filled 

 Formatting text - font, style, color, size, 

alignment 

 Formatting values - currency etc. 

 Borders and cell grid 

 Formatting painter tool 

 Changing column widths - manual, 

calculated, automatic 

 Changing row heights - manual, calculated, 

automatic 

 Start a multiplication table from 12*500 

then increase to 12*1000 

 Show fill down 

 Show fill series 

 Relative vs. absolute references 

 Triple the length of the first spreadsheet 

 Look at my grade spreadsheets 

 What functions are built into Excel? 

 Use the sample spreadsheet functions to 

examine commonly used functions in 

spreadsheets 

 Class creates a simple spreadsheet  

 Page set-up and formatting 

 Headers and footers 

 How to print a spreadsheet 

 Combining functions 

 Paste functions with the Fx command button 

 Go back to my grade spreadsheet and 

explain how it calculates answers 

 Sorting 

 Copy/paste functions 

 Paste Special command 

 Add grades to my spreadsheet 

 Explain the lookup function to calculate 

letter grades 

 Delete students 

 Add students 

 Review mulch guide with absolute 

references 

 Check temperature conversion and show 

negative numbers 

 Create a grade spreadsheet using the sample 

functions for assignment 

 Special functions like now, time, convert, 

etc. 

 Formatting page - headers, footers, margins, 

grid, and border 

 Printing spreadsheets 

 Creating simple charts 

 Data series and categories 

 Advanced charts 

 Graphing stock quotes from the internet 

 Using draw tools in Excel spreadsheets 

 Add AutoShapes and WordArt to a 

spreadsheet 

 Using a spreadsheet in Microsoft Word 

 Independent project 

 


